
OpenTrap Introduction
OpenTrap is a 32-bit Windows 95 application that monitors file system activity on your computer. 

OpenTrap is not designed for and will not run under either Windows 3.1 or Windows NT (any version).

To install OpenTrap, simply place the component files OPENTRAP.EXE, OPENTRAP.HLP, and 
OPENTRAP.CNT in the directory of your choice. Move the FUNCTRAP.VXD file to either your Windows 
SYSTEM directory or any other directory that's included in your system's PATH statement. Finally, create 
a shortcut to OPENTRAP.EXE.

IMPORTANT NOTE: If you also have the PC Magazine Utility "BigBin" installed on your 
system, you should be aware that OpenTrap and BigBin both use the 
FUNCTRAP.VXD virtual device driver. For the two programs to work together, there 
must be exactly one copy of FUNCTRAP.VXD on your system, either in your 
Windows SYSTEM directory or any other directory that's on the system PATH.

OpenTrap uses the FuncTrap VxD to record a log of every file opened or closed. This log can be 
useful in diagnosing problems such as a program that refuses to launch because "one or more 
components are missing". In addition to displaying the log on your screen, it can print the log to your 
printer and export it as ASCII text for use by other programs (such as a database or spreadsheet).

OpenTrap can save your event logs in its own native format for later use; the default extension for log 
files is .OTL. Each time you launch OpenTrap, it will check your system Registry to see if the .OTL 
extension is registered. If not, it will automatically register the .OTL extension as the "OpenTrap Event 
Log" file type, allowing you to either open or print .OTL files directly from within Windows Explorer – just 
right-click on the file and select the desired action from the pop-up menu.
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File menu commands
The File menu offers the following commands:

New Creates a new, empty log.
Open Opens an existing log.
Save Saves the current log using the same file name.
Save As Saves the current log to a specified file name.
Save As Text Writes the current log as a text file.

Print Prints the current log.
Print Setup Selects a printer and printer connection.

Exit Exits OpenTrap.



View menu commands
OpenTrap’s logs can be very large. If necessary, it subdivides the current log into logical pages 

containing up to 1024 records each. The actual number of records per page depends on your current font 
size. You may use the mouse and scrollbars or the keyboard arrows to scroll within the current page. Use 
the commands on this menu (or their associated toolbar buttons or accelerator keys) to move from page 
to page, determine how each record is displayed, and select which records are shown.

The View menu offers the following commands:

Filter Options Lets you apply various filters to determine which records
are shown or printed

First Page
Last Page
Previous Page Navigate between pages in the current log.
Next Page
Go to page...

File Toolbar Shows or hides the File toolbar.
Navigation Toolbar Shows or hides the Navigation toolbar
Status Bar Shows or hides the status bar.
Record Numbers Display absolute record number at the beginning of 

each line.

Custom Font Select a font other than the system default for display 
and printing

Default Font Revert to the system default font

Logging menu commands
The Logging menu offers the following commands:

Start (or Resume) Logging Begins logging file system events.
Stop Logging Stops logging file system events and, if log is not 

empty, displays the contents of the current log.

Options Presents a dialog used to select which events will be 
logged.

Help menu commands
The Help menu offers the following commands, which provide you assistance with this application: 

Help Topics Offers you an index to topics on which you can get help.
About Displays the version number of this application.

New command (File menu)
Use this command to create a new, empty, even log. If the current log is not empty and has not been 

saved, you will be prompted to do so before it is discarded.

You can open an existing log with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)
Use this command to open an existing log. If the current log is not empty and has not been saved, 

OpenTrap will prompt you to save it.

You can discard the current log with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box
The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. The default extension for OpenTrap’s log files is .OTL.

List Files of Type
Select the type of file you want to open. OpenTrap will only open files that have the .OTL extension.

Drives
Select the drive in which OpenTrap stores the file that you want to open.

Directories
Select the directory in which OpenTrap stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)
Use this command to save the current log to its current name and directory.    When you save a log for

the first time, OpenTrap displays the Save As dialog box so you can name your log.    If you want to 
change the name and directory of an existing log before you save it, choose the Save As command.

If the current log is empty, this command will be disabled – OpenTrap will not save an empty log.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)
Use this command to save and name the active log.    OpenTrap displays the Save As dialog box so 

you can name your log.

If the current log is empty, this command will be disabled – OpenTrap will not save an empty log.

To save a log with its existing name and directory, use the Save command.



Save As Text command (File menu)
Use this command to save the current log in text format. This is useful if you wish to process 

OpenTrap’s information using another program.

If the current log is empty, this command will be disabled – OpenTrap will not save an empty log.

This command first presents the Export Options dialog, in which you determine the format of the file. 
After you OK the Export Options dialog, OpenTrap presents a Save As dialog in which you enter or select 
the name of the file that OpenTrap will write. The default filename will be the same as the current log (as 
displayed in the main window’s title bar) but with the extension “.txt”. Unlike the Save or Save As 
commands, specifying a different filename here does not change the name of the log.

Shortcuts

Toolbar:
Keys: CTRL+T



File Save As dialog box
The following options allow you to specify the name and location of the file you're about to save: Note 

that when the Save As Text command presents this dialog, entering a different filename does not change 
the name of the current log.

File Name
Type a new filename to save a log or export a text file with a different name. OpenTrap adds the 
extension you specify in the Save File As Type box. By default, OpenTrap’s logs use the 
extension .OTL

Drives
Select the drive in which you want to store the log.

Directories
Select the directory in which you want to store the log.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Export Options dialog box
This dialog appears when you select the Save As Text command. Files created this way will always 

contain plain ASCII text, one record per line. The settings in this dialog let you control which records will 
be written as well as the format of each line.

The Filtered Records Only checkbox determines which records will be written to the file. If there are 
no view filters in effect, this checkbox will be disabled. Otherwise, checking the box means that OpenTrap
will only write the same records that you see displayed in the main window. Leaving the box unchecked 
tells OpenTrap to write every record in the current log.

The Include Record Numbers check box means just what it says. When checked, OpenTrap will 
precede each record with its absolute record number. This setting is independent of the View menu’s 
Record Numbers command. Note that if output is filtered, the record numbers may not be in direct 
sequence because they represent each record’s physical location in the log. However, records will always
be written in ascending order.

The radio buttons in the Output Format box determine the way the records are written. The Plain 
Text option means that they will be written in exactly the same form that you see in the main window. The 
Comma-delimited option produces output that is more suitable for use by another program (such as a 
database or spreadsheet). In this format, each record is written as a series of fields separated by 
commas. Except for the record numbers, each field will be a single string enclosed in quotes, in the 
following order and format:

Field Format
Record Number A six-digit ASCII number padded with leading zeroes.

Module Name ASCII text, which will never be more than 11 characters long.

Event A two-character string. The first character will always be either O for Open or a C 
for Close. The second character will be either a space (event succeeded) or an 
asterisk (event failed).

File Name The name of the file, just as you see it in the main window. This string may be up 
to 260 characters long. Note that for Close events, this field may contain a string 
of the form "A file on drive d:" instead of an actual filename. This means that 
OpenTrap was not able to determine the name of the file that was closed, only 
the drive on which it resided.

Time The system time when the event occurred. This will always be a twelve character
string of the form hh:mm:ss.ddd. Note that the times for events that occur in 
direct succession may be identical. This is because the events occurred within an
interval smaller than that used by the system clock, which is approximately 1/18th
of a second.



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four logs you 

closed.    Choose the number that corresponds with the log you want to open. If OpenTrap is logging, 
these commands will be disabled – you must stop logging before you can load a log file.



Exit command (File menu)
Use this command to end your OpenTrap session. You can also use the Close command on the 

application Control menu. If OpenTrap is logging when you issue this command, it will ask you if you want
to stop logging. If you answer "NO" and the Hide main window while logging option is active, OpenTrap 
will hide the main window and return to its system tray icon.

When OpenTrap does shut down, it will prompt you to save the current log if necessary.

Shortcuts
Mouse: Double-click the application's Control menu button  or single-click the close button. 

Keys: ALT+F4



Filters command (View menu)
This command presents a dialog that lets you filter the current log display based on several criteria. 

Note that this filter only affects what information is displayed, not the contents of the log itself. If you wish 
to limit the amount of information captured during a session, use the Logging Options command.

When the view is filtered, OpenTrap displays "FILT" indicator in the status bar. If the view is filtered 
when you use the Save As Text command, the Export Options dialog will let you choose whether or not to 
use the filter when writing the file.

These options do not affect the contents of an .OTL file saved with the usual Save or Save As 
commands.

Shortcuts

Toolbar:



Filter Options dialog
The settings in this dialog determine which records OpenTrap will display in the main window. This 

does not affect the contents of the log, only what portion of it is displayed or printed. If you specify more 
than one filter option, each record must match all of the filters for OpenTrap to display it.

The Reset button removes all filters. If the Save Settings box is checked when you OK the dialog, 
OpenTrap will save your filter settings and use them automatically the next time you launch the program. 
Clicking the Cancel button, the close box, or pressing {Esc} closes the dialog without changing your filter 
settings.

To use the Base Name, Extension, or Module Name filters, check the appropriate box. OpenTrap 
will enable the corresponding edit box and shift the focus there so you can either enter or edit your filter 
string. If you clear one of these check boxes, the filter is disabled but OpenTrap remembers your filter 
string in case you want to use it again later without having to re-type it.

If you choose to use either the Base name or Extension filters, keep the following in mind:

· Filenames are not case-sensitive.
· The Base Name begins with the first character after the last backslash in the fully-

qualified name and ends with the last character before the last "." (if there is one) 
that marks the beginning of the file extension.

· The Extension begins with the first character after the last "." in the filename, if 
there is one. To filter out filenames that have no extension, check the Extension 
checkbox but delete all characters from the edit field so it is empty.

· You may use the standard wildcard characters * and ?. The ? wildcard will match any 
character in the corresponding position. The * wildcard is allowed only at the end of a
filter string. If used, it matches all remaining characters in that portion of the 
filename.

The Module name field is not case-sensitive and can be no more than 8 characters long. To filter for 
events generated by <unknown> modules, check the Module Name box but delete all characters from the
edit box. This field does not accept wildcards.



First Page command (View menu)
Displays the top of the first page of the current log.

Shortcuts

Toolbar:
Keys: CTRL+Home



Last Page command (View menu)
Displays the end of the last page of the current log.

Shortcuts

Toolbar:
Keys: CTRL+End



Previous Page command (View menu)
Displays the end of the previous page of the current log.

Shortcuts

Toolbar:
Keys: CTRL+PgUp



Next Page command (View menu)
Displays the start of the next page of the current log.

Shortcuts

Toolbar:
Keys: CTRL+PgDn



Go to Page command (View menu)
Lets you enter the page number to be displayed.

Shortcuts

Toolbar:
Keys: CTRL+G



File Toolbar command (View menu)
Use this command to display or hide the File Toolbar, which includes buttons for some of the most 

common commands in OpenTrap, such as File Open.    A check mark appears next to the menu item 
when the File Toolbar is displayed.



File Toolbar

The toolbar is displayed on the left side of the application window.    The toolbar provides quick mouse
access to file-related commands in OpenTrap,

To hide or display the File Toolbar, choose File Toolbar from the View menu (ALT, V, T).

Click To

Open a new log.

Open an existing log.    OpenTrap displays the Open dialog box, in which you can locate and open
the desired file.

Save the active log or template with its current name.    If you have not named the log, OpenTrap 
displays the Save As dialog box.

Export the active log as a text file.

Print the active log.

Start or resume logging file system events.

Stop logging file system events and display the current log.

Set logging options.



Toolbar Docking
You can dock OpenTrap's toolbars to any side of the main window or have them floating freely around

the screen. Just click on an open area of the toolbar with the left mouse button, drag its outline (which will 
change its size and shape appropriately) to the desired position, and release the left mouse button. 
OpenTrap automatically saves the toolbar's docking position when you exit the program.



Navigation Toolbar command (View menu)
Use this command to display or hide the Navigation Toolbar, which includes buttons used to control 

the appearance of the display and to move from one display page to another.    A check mark appears 
next to the menu item when the Navigation Toolbar is displayed.



Navigation Toolbar

This toolbar is displayed on the right side of the application window.    The toolbar provides quick 
mouse access to view-related commands in OpenTrap,

To hide or display the Navigation Toolbar, choose Navigation Toolbar from the View menu (ALT, V, V).

Click To

Set filtering options.

Display or hide individual record numbers.

Move to the first page in the log.

Move to the previous page in the log.

Move to a specific page in the log.

Move to the next page in the log.

Move to the last page in the log.

Select a custom font.

Restore system default font.



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be executed by 

the selected menu item or depressed toolbar button and other program information. A check mark 
appears next to the menu item when the Status Bar is displayed.



Status Bar

The status bar is displayed at the bottom of the OpenTrap window.    To display or hide the status bar, 
use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate one or more of the following conditions:

Indicator Description
LOGGING OpenTrap is logging system events
IDLE OpenTrap is not logging file system events.
Log Is Full OpenTrap is idle and the log buffer is full.
FILT Your view of the current log is filtered.

The rightmost panel in the status bar indicates the status of the current log. When OpenTrap is idle, it 
indicates which logical page you are currently viewing. When OpenTrap is logging, it displays the 
approximate number of records in the log.

To minimize its impact on your system's performance while logging, OpenTrap does not update the 
record count dynamically. Instead, it only updates the status bar when the main Window enters the idle 
state (that is, it has no input to process). You can force the record count to update by simply passing the 
mouse pointer over the main window. This causes the window to "wake up" to handle the mouse 
movement events. When the mouse pointer either stops moving or moves outside the window's borders, 
the window re-enters the idle state and OpenTrap updates the status bar.



Record Numbers command (View menu)
Shows or hides the record number at the beginning of each line, both in the screen display and in 

printouts. However, this setting is independent of the option presented when exporting a log as a text file.

Shortcuts

Toolbar:



Custom Font command (View menu)
Presents a Font dialog so you can select a font other than the system default for the screen display 

and printed output. OpenTrap remembers the font setting that was in use when you end the program.

Shortcuts

Toolbar:



Default Font command (View menu)
Cancels your custom font selection and reverts to the system default font. OpenTrap remembers the 

font setting that was in use when you end the program.

Shortcuts

Toolbar:



Choose Font dialog box
This dialog appears when you select the Custom font command. Use it to choose an alternate 

typeface, size, and style to be used both for displaying and printing your logs. OpenTrap automatically 
remembers the font that was in use when you exit the program.



Start Logging command (Logging menu)
This command tells OpenTrap to begin logging file system events. If the current log is not empty, 

logged events will be appended to it. Logging continues until either:

· You issue the Stop LoggingHID_LOGGING_STOP command.

· OpenTrap’s buffer fills.

· You end the current Windows session, in which case OpenTrap will prompt you to save the 
current log if necessary. Canceling the save request will prevent Windows from shutting down.

Shortcuts

Toolbar:



Stop command (Logging menu)
Stops logging file system events and displays the contents of the current log. OpenTrap will stop 

logging automatically when its buffer fills or you end the current Windows session.

Shortcuts

Toolbar:



Options command (Logging Menu)
Presents a dialog letting you control which file system events are logged, the size of the log buffer, 

and whether or not OpenTrap will hide its main window and run from a system tray icon while logging.

Shortcuts

Toolbar:



Logging Options dialog
This dialog lets you control the size of OpenTrap's log buffer and limit what information it will record. 

For more information about individual settings, click on a control in the image below. You can also get 
help in the dialog itself by right-clicking a control and selecting "What's this?" from the pop-up menu.

NOTE: When the Hide main window while logging box is checked and OpenTrap is logging, 
closing the main window does not exit the program—it just hides the window again. If you wish to exit the 
program, you must stop logging first.



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can click 

either the Contents, Index, or Find tabs to locate specific help topics.

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of OpenTrap.



Context Help command 

Use the Context Help command to obtain help on some portion of OpenTrap.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the OpenTrap window, such as another Toolbar button.    The Help topic will be shown for 
the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar
The title bar is located along the top of a window.    It contains the name of the application and log.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:

Application Control-menu button
Maximize button
Minimize button
Restore button

 Close button

Name of the log



Scroll bars
Displayed at the right and bottom edges of the main window. The scroll boxes (or “thumbs”) inside the

scroll bars indicate your vertical and horizontal location in the log, and the relative size of the thumb 
compared to the size of the entire scroll bar corresponds to the size of the window compared to the size 
of the entire log. You can use the mouse to scroll to other parts of the log.

Clicking the arrows at the top or bottom of the vertical scroll bar will scroll the display one line at a 
time. Clicking in the area between the thumb and an arrow scrolls one page in that direction.

On the horizontal scroll bar, clicking between the thumb and an arrow scrolls by the width of the 
window. Clicking on the arrows at either end scroll 1/10th of that distance.



Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with the arrow 

keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or dialog box 

with the arrow keys.

Note:    This command is unavailable if you maximize the window.
Shortcut

Mouse: Drag the window's title bar.



Minimize command (application Control menu)
Use this command to reduce the OpenTrap window to an icon.

Shortcut
Mouse: Click the minimize icon  on the title bar.



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Close command (Control menus)
Use this command to close the active window or dialog box. Closing OpenTrap's main window ends 

the program, prompting you to save the current log if necessary.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts

Mouse: Click the close icon  in the title bar.
Keys: ALT+F4 closes the OpenTrap window or dialog box



Restore command (Control menu)
Use this command to return the active window to its size and position before you chose the Maximize 

or Minimize command.

Shortcuts
Mouse: Click the restore icon  in the title bar.



Modifying the Log
The only way to modify an OpenTrap log is to append records to it using the Start Logging command. 

OpenTrap does not allow deleting, inserting, copying, or editing records because the meanings of some 
records depend on others (see How OpenTrap logs events for more information). Arbitrarily editing or 
deleting records could make it impossible for OpenTrap to display the log in a meaningful way.



No Help Available
No help is available for this area of the window.



No Help Available
No help is available for this message box.



How OpenTrap logs events
The actual “grunt work” of logging events is performed by the FUNCTRAP.VXD virtual device driver. 

OpenTrap loads the device driver into memory, then launches a worker thread to monitor the device 
driver’s activity. When this thread starts, it sends the device driver either one or two condition records that 
tell the driver which events to capture. When a matching event occurs, the device driver calls a function in
OpenTrap, passing it information about the event. This callback function is responsible for processing this 
information and, if necessary, appending it to the log in memory.

When logging stops, Open trap parses the log so that it can display filenames for Close events. This 
extra processing is necessary because FUNCTRAP.VXD cannot report the name of a file when a handle 
is closed, only the drive letter on which the file resided. Therefore, OpenTrap has to do some extra work 
to display this information for you, taking advantage of the way Windows keeps track of files. When an 
application or process opens a file, the file system    creates a handle, which is essentially an arbitrary 32-
bit number, that the application uses to access that file. Once created, a handle refers to the same 
physical file until it is released by all applications that may be using it. At that point, the handle is 
destroyed and the numeric value it contained is "recycled" so that it can be used again. OpenTrap stores 
these handles but it does not display them because they only have meaning while they are in use by an 
application. That is, a given handle value could be used to refer to many different files during the same 
logging session.

 Each time logging stops, OpenTrap scans through the entire log in memory. When it encounters a 
Close event, it stops and looks backward in the log until it finds an Open event for the same handle value.
If it does, it sets the current Close event’s filename pointer to point to the filename for the corresponding 
Open event. This allows OpenTrap to display the name of the file that was closed without requiring 
additional storage for an duplicate copy of the filename.

This mechanism also means that OpenTrap may not always be able to determine the filename for a 
Close event. Specifically, if a file was opened before OpenTrap began logging and then closed while 
logging was in progress, OpenTrap will not be able to find a matching “Open” event for that handle. When
this happens, OpenTrap displays the generic “Closed a file on drive d:” message instead of a true 
filename.



About the log buffer
To minimize its impact on your system, OpenTrap logs events by copying them directly to a log buffer 

in memory, and it does not manage this buffer's size dynamically. Instead, the buffer is fixed in size and 
OpenTrap automatically stops logging if the buffer fills.

You can change the buffer size in the Logging Options dialog box. The absolute minimum is either 
64K or large enough to hold the current log (whichever is larger). The absolute maximum is 2048K. This 
setting does not affect the size of a log file when saved to disk, only the amount of memory reserved for 
the buffer. When you save a log to disk, OpenTrap only writes the portion of the buffer that actually 
contains valid data.

When you load a log file from disk, OpenTrap first checks the current buffer size. If it is not large 
enough to hold the file, OpenTrap will reallocate the buffer as needed and (if possible) add an extra 16K 
to allow you to append records to the log.



Command Line Options
OpenTrap accepts the following switches and arguments on the command line, which is not case-

sensitive.

Switches begin with either "/" or "-", consist of a string of one or more non-blank characters, and must 
be separated by spaces or tabs. The order of switches is not important, but they must be separated by 
spaces.

An argument is any string of text not beginning with either "/" or "-". If arguments contain any spaces 
or other special characters, they must be enclosed in quotes. The order of arguments is important. In 
order they represent a filename, a printer name, a printer driver name, and a port name.

filename Tells OpenTrap to open the specified log file. If the file does not exist or could 
not be opened, OpenTrap presents an error message and terminates.

/P filename Tells OpenTrap to print the specified file to the default printer and terminate. 
The filename is required. This option prints the file using the filter and view 
settings stored in the Registry unless you override them on the command line.
If you set a custom font the last time you closed OpenTrap, that font will be 
used for the printout.

/PT filename printer driver port
Same as /P, but prints to the specified device.

/A Starts logging immediately after startup. Ignored if /P or /PT is used.

/U Uninstalls OpenTrap. When specified, OpenTrap asks if you wish to proceed 
with the uninstall process. If you do, all other command-line switches and 
arguments are ignored. Otherwise, the remaining switches and arguments are
processed normally. See Removing OpenTrap from your System for further 
information.

The remaining options are used to set logging (/L), export (/E), and filtering (/F) options. If any of 
these switches are specified, with or without arguments, all settings within that "family" revert to their 
default values, regardless of the settings stored in the Registry. This ensures that operation from the 
command line will be consistent: you only need to specify those settings that are not defaults.

/L[options] Sets logging options. Settings specified via this switch will not be retained 
unless you save them manually via the Logging Options dialog. This switch 
accepts the following options:

H Hide main window while logging. (default = don't hide)
E Errors only (default = all events)
O Open events only (default = Opens and Closes)
A All apps (default).
D DOS apps only.
W Windows apps only.
If more than one of A, D, or W is specified, OpenTrap will use the one that 
appears last.

/E[options] Sets Export options. Settings specified on the command line become the new 
defaults unless you change them manually by exporting a text file. Options 
are:

R Record numbers (default = no record numbers).
C Comma-delimited format (default = plain text).
F Filtered records only (default = all records).

/B[number] Sets the log buffer size. If you also specified the name of a log file to load or 
print, OpenTrap will override this setting if necessary. The number must range 



from 64 to 2048. If the value specified is too small, 64 will be used. If it is too 
large, 2048 will be used. OpenTrap will not retain this setting unless you save 
it manually via the Logging Options dialog. 

/R[option] Sets the View/Record Numbers option. This setting is saved automatically 
when OpenTrap terminates.

S Show record numbers.
H Hide record numbers (default).

/F[option] Sets filtering options. Options specified via this switch will not be retained 
unless you save them manually via the Filter Options dialog. The options for 
this switch cannot be "stacked". You must specify /F separately for each filter 
(B, E, M, and/or T) that you wish to set. String arguments for the B, E, and M 
options must not be separated by a space, and must be quoted if they contain
spaces or other special characters.

B"string" Sets the base name filter. If "string" is omitted or empty, this 
option is ignored and the base name filter is turned off.

E"string" Sets the extension filter. To "string" is omitted or empty, filters 
for files with no extension.

M"string"Sets the module name filter. If "string" is omitted or empty, 
filters for the "<unknown>" module.

T[opts] Sets the event type filters. Options (which can be combined) 
are:
O = Opens only (default = Opens and Closes)
E = Errors only (default = All events)

For example, if you want to print the file MYLOG.OTL and show only files that were opened by 
<unknown> modules with the Base Name of "MY*" and the extension of "TXT",    the command line would
read:

OPENTRAP /P mylog.otl /fb"my*" /fb"txt" /fb /fto



Removing OpenTrap from your system
To remove OpenTrap, launch the program with the /U switch on the command line. OpenTrap will ask 

if you wish to proceed. Answer Yes, and OpenTrap will remove all of its settings from the system Registry.
If it detects that the .OTL file extension is not registered to OpenTrap, it will ask whether or not you wish to
remove that association.

Once the uninstall process is complete, you may delete OpenTrap's files from your hard disk.

IMPORTANT: If you also have the PC Magazine Utility "BigBin" installed on your system, 
do not delete the FUNCTRAP.VXD virtual device driver. BigBin requires that file to 
operate.



Records activity for all applications



Records activity for Windows applications only



Records activity for DOS applications only



Enter a value here (up to 2048) to change the buffer size. The minimum buffer size is either 64K or large enough to hold the current 
log, whichever is larger.
Changing the buffer size will not affect the current log's contents.



Displays the amount of space available in the buffer



Tells OpenTrap to run from an icon in the system tray while logging. Double-clicking the tray activates the main window so you can 
either stop logging or check the log status. If you don't stop logging first, closing the main window does not exit the program, it just 
hides the window.



Check this box to save your settings as the
new defaults when you OK the dialog



Records both Open and Close events



Records Open events only



Records only events that failed



Determines which application types will be monitored



Determines which event types will be recorded



These options determine which events will be displayed



Shows all events



Shows open events only



Shows close events only



Shows only events that failed



Removes all filters



These settings filter the display by filename and extension



Activates or deactivates the base name filter



Activates or deactivates the extension filter



These settings filter the display by module name



Activates or deactivates the module name filter



Edit the base name filter string. You may use the ? wildcard
to match any single character and/or the * wildcard at the end
of the string to match all remaining characters.



Edit the extension filter string. You may use the ? wildcard
to match any single character and/or the * wildcard at the end
of the string to match all remaining characters. To search for
files with no extension, leave this field empty.



Edit the module name filter string. Wildcards are not allowed.
To specify the <<unknown>> module, leave this field empty.



When checked, exports only those records that match the current view filters



When checked, includes absolute record numbers.
NOTE: This setting is independent of the screen display.



These settings control the content of the exported file



Writes each record as you see it on the screen



Writes each record in comma-delimited format



Indicates the range of pages in the log



Enter the number of the page you wish to see.



Error: Could not load FUNCTRAP.VXD
This message means that OpenTrap could not load the FUNCTRAP.VXD virtual device driver. This 

usually indicates that FUNCTRAP.VXD is either missing, damaged, or in the wrong place. 
FUNCTRAP.VXD must be located in one of three places:

1. In the same directory as OpenTrap.

2. In your \WINDOWS\SYSTEM directory.

3. In any directory that's included in your system PATH.

IMPORTANT: OpenTrap shares the FUNCTRAP.VXD device driver with the PC Magazine Utility 
BigBin. If you have BigBin installed, there must be exactly one copy of FUNCTRAP.VXD on your system. 
If you do not have both programs installed in the same directory, FUNCTRAP.VXD must be placed in a 
directory that's included in your system's PATH statement; ideally, in the \WINDOWS\SYSTEM directory. 
Otherwise, you can put it in the same directory as BIGBIN.EXE and OPENTRAP.EXE



Error: Unable to launch worker thread
This message occurs when OpenTrap is unable to launch the background process that monitors file 

system events. This is usually caused by either insufficient available memory or too many processes 
already running.



Error: Log start failure
This message means that OpenTrap was unable to start logging. The exact cause of the failure was 

indicated by the preceding error message. This error does not affect the contents of the current log.



Error: Invalid file format
The file you attempted to load is either damaged or was not an OpenTrap log to begin with. 

(OpenTrap places a "signature" at the beginning of its log files, so it can identify its own files regardless of
their names.) The operation was abandoned, and the contents of the current log remain unchanged.



Error: Memory allocation failure
This message occurs when you attempt to load a file that is too large to fit within the current buffer. 

OpenTrap attempted to enlarge the buffer to hold the file, but there was not enough memory available. 
The buffer size remains the same, and the current log contents are not affected.

You may be able to remedy this error by using the Options command from the View Menu to increase 
the buffer size manually, then try loading the file again. If that fails, you will have to close one or more 
applications to make more memory available.



Error: Invalid filename
This message indicates that either the Base Name or Extension string you entered is invalid. While 

you can use the standard "?" and "*" wildcards in these fields, the * wildcard can appear only once: at the 
end of the string. When used, it matches all remaining characters in that portion of the filename. For 
example, if you're setting a Base Name filter, then:

"FOO*" matches any base name at least three letters long that begins with the letters "FOO"

"B?R*" matches any base name at least three letters long whose first letter is "B" and third letter is 
"R".

"SNAF?" matches any base name beginning with "SNAF" that is exactly five characters long.

Note that if you're filtering for a long filename that contains blank spaces or other special characters, 
you do not have to enclose your filter string in quotes. Except for wildcards, OpenTrap interprets every 
character in the string literally.



Error: Invalid module name
The Module Name box is checked, but the filter string you entered is invalid. Specifically, the wildcard

characters "?" and "*" are not allowed – OpenTrap can filter only for a specific module name. If you wish 
to filter the display to show only files accessed by <unknown> modules, you must delete all characters 
from this field.



Error: Base Name filter cannot be blank
If the Base Name box is checked, the filter string cannot be empty. It must contain at least one non-

blank character.



Do you wish to stop Logging?
This prompt appears when you attempt to close OpenTrap's main window while logging is in 

progress. Answering Yes will stop logging and terminate the program. If the contents of the current log 
have changed, you will given the opportunity to save the log to disk.

If the Hide main window while logging option is active, answering No to this message will hide the 
main window without terminating the program.



Print command (File menu)
This command prints the current log to your printer using the current font and view filters. Note that 

OpenTrap does not allow you to select the number of pages to print because this varies depending on the
font and page size. The number of pages produced bears no relation to the number of logical pages in the
display because the print function wraps lines to fit the page as needed.

When you select this command from the menu, it presents a standard Print dialog box in which you 
can select a printer and/or printer settings, or cancel the operation. If you use the toolbar icon, OpenTrap 
prints immediately using the current settings, without presenting the print dialog.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box
The following options allow you to specify how the log should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
This option is disabled. OpenTrap always prints the entire log using the current view filters. The 
number of pages printed depends on the size of the current font and usually will not correspond with 
the number of logical pages available in the main window:

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog
The Printing dialog box is shown during the time that OpenTrap is sending output to the printer.    The 

page number indicates the progress of the printing.



Print Setup command (File menu)
Use this command to select a printer and a printer connection.    This command presents a Print 

Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box
The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.




